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The Digital Viking 
 The Digital Viking is the official monthly publication of 
the Twin Cities PC User Group, a 501(c)(3)organization and an 
all-volunteer organization dedicated to users of IBM-compatible 
computers. Subscriptions are included in membership. We wel-
come articles and reviews from members. The Digital Viking is a 
copyrighted publication and reproduction of any material is 
expressly prohibited without permission. Exception: other User 
Groups may use material if unaltered and credited. 
 Disclaimer: All opinions are those of the authors and do 
not necessarily represent the opinions of the TC/PC, its Board of 
Directors, Officers, or newsletter staff. TC/PC does not endorse, 
rate, or otherwise officially comment on products available; 
therefore, readers are cautioned to rely on the opinions presented 
herein exclusively at their own risk. The Digital Viking, its 
contributors, and staff assume no liability for damages arising out 
of the publication or non-publication of any advertisement, 
article, or other item. All refunds in full or in partial, for advertis-
ing, membership or any other item shall be at the sole discretion 
of the Twin Cities PC User Group Board of Directors. 
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Two-thirds page (7½ x 6) 80.00 
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One-third page (7½ x 3) 50.00 

Quarter page (3½ x 4¾) 40.00 

Member Bus. Card (2 x 3½) 10.00 

Multiple insertion discounts available. 

Contact Sharon Walbran at:: SQWalbran@yahoo.com 

Deadline for ad placement is the 1st of the month prior to publica-
tion. All rates are per issue and for digital or camera-ready ads. 
Typesetting and other services are extra and must be requested in 
advance of submission deadlines. 

Payment must accompany order unless other arrangements are 
made in advance. Place make checks payable to: Twin Cities PC 
User Group 
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I Wuz Hacked  
By Stu Gershon, Smartphone SIG Leader, Sun City Summerlin Computer Club, NV 

December 2017 issue, Gigabyte Gazette 

www.scscc.club/  

tomburt89134 (at) cox.net 

One Sunday morning, I checked my email, like I do every morning. Nothing came through. I 

tried again, and it was the same. I called COX to see if any of their servers were having 

trouble or down. The line was busy. The line is never busy unless they are having trouble 

because they’ve always had fantastic customer service. I tried twice more during the day 

with the same results.  

 

I finally got through to COX at about 6:30 that evening. They were not having any problems, 

and they couldn’t help me because I have Gmail accounts and they would only intervene if 

they were COX accounts. I said to the technician, “What should I do?” He replied, “Call 

Google!” I said, “Who are you going to call at Google, they have no customer service!” He 

offered, “I have a number for Google support!”  

 

He gave me the number and the first thing Monday morning I called 1-844-400-1570. I asked 

if they were “Google Support” and the gentleman said “Yes.” His name was Daniel. We 

discussed the problem and he said I’d have to let him into my computer, so he could check. 

REMEMBER - COX gave me this number. I had to give permission and put in a code number 

to let him into my computer. He looked around for a while, “scanned” my computer for 

viruses and malware and told me I had probably been “hacked.” I asked, “What do we do 

now?” Daniel said he’d fix it and said the charge would be $299.99 including a one-year 

warrantee on my computer. I figured it was worth it to get this problem fixed.  

 

He continued to work on my computer, while I watched what he did, and we talked over 

the phone, throughout. He worked on my computer until 5:30 pm (from 9:30 am) and said 

he did what he could, the email was working with some “work-a-rounds,” but it was the end 

of his shift and he’d call me back at 10 am the next morning.  

 

He asked to be paid, and since my computer was adequately working and he’d been 

working on it for 8 hours, already, I gave him my credit card and paid the $299.99.  

 

The next morning, at 10 am, he called back and worked on it until almost noon. He’s put ten 

hours into my computer, he had given me his name, and said he’d call back the following 

week to check if everything was alright. With Daniel’s “work-a-round,” my computer worked, 

fine.  

 

On Tuesday, September 12th, he called back promptly at 10 am, said “hello” and asked 

how everything was working. I told him it was working fine, but by adding the “work-a-

round” (a new email address getting the email from the old one), I was getting a lot of 

duplicate emails. He took another look, but this time he used a different software.  
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Since Gigabyte Gazette on 18 December 2017 we were still in communication over the 

phone, I asked “why?” and he replied, “My company has installed a new software in the 

past week.”  

 

The guy had already worked on my computer for TWELVE HOURS and, remember, I CALLED 

HIM! He said, “Look, you’ve been hacked, so I’m going to refund your money because we 

didn’t do our job!”  

 

He said, “Let me be sure.” Then my PC’s screen went BLACK! I asked, “Daniel, what’s going 

on?” He replied, “It’s the new software, don’t worry.” Coincidently, my cell phone was right 

next to my computer. As the screen was black and I couldn’t see what he was doing, I 

received text messages on my cell phone, “PayPal Gift Card - $100!” “PayPal Gift Card - 

$50!” On and on. I asked Daniel, “What’s going on?”  

 

He answered, “Nothing, I’m fixing your computer!” I answered, “Money is being taken from 

PayPal!” He replied “Don’t worry! It’s so we can give you your refund!”  

 

I said, “Not from what I see! Goodbye!” and I pulled the plug! I immediately called PayPal, 

and stopped the $450 in Gift Card charges! Then I called my Bank and put a freeze on all 

my credit cards. Remember, Equifax had been hacked the week before, so they were NO 

HELP!  

 

Then I called Amazon, where I spend much of my money. They informed me they had 

“denied” a charge for a $500 gift card (because I had never ordered something like that 

before, and they were trying to contact me to verify, but my computer and two phones 

were all in use – it’s called “profiling”.)  

 

I called my friend, Chuck, at the Computer Club and he told me to bring my computer over 

(the Tuesday Repair SIG – Special Interest Group, had just started). I brought it over and 

when the guys started up my computer it required a password (which I had not made) to 

enter.  

 

This is called RANSOMEWARE – They lock up or scramble your computer and make you pay 

a fee to release your computer from their control! Chuck, and the other guys, took out the 

hard drive, did something to it to remove the password, and then I got my external hard 

drive and we restored the computer to BEFORE this incident began.  

 

In the meantime, Daniel called five times and told me to buy three $100 iTunes gift cards, 

and when I put in the pin numbers from the back of each card, the “hack-ware” would be 

uninstalled! He had already taken $299.99 in payment for his services, tried to buy $450 in 

PayPal gift cards, tried to purchase a $500 gift card from Amazon, and now he wanted 

$300 more? Nope! So now, two weeks later, I’ve restored my main computer, the email is 

working fine, I’m currently restoring my second laptop because I also allowed Daniel to 

check those email settings. I’ve changed all my credit cards and my passwords and I’m 

exhausted. I haven’t lost any of the “charges” yet, because they are all in “dispute,” and 
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because PayPal, Amazon and my bank worked quickly, and I’m disputing the initial charge 

of $299.99.  

 

If that’s the price I must pay, “A lesson learned, is a lesson earned!” and maybe someone 

can benefit from this experience. REMEMBER – I called Daniel because my trusted Internet 

Provider GAVE ME THE PHONE NUMBER!  

 

The only people SCSCC members should let into their computers are our Computer Club’s 

Repair SIG which meets every Tuesday from 1 to 4 pm in the Computer Club Classroom at 

the Pinnacle, and the only requirement is joining the Computer Club! They know what they 

are doing, and they live HERE!” 

 

From Judy [Judy Taylour of APCUG]: This article leads into a great discussion with your group 

members on who they trust to work on their computers, and why. If a member doesn’t have 

a trusted person, they might think about introducing themselves to another member’s 

trusted person. I, personally, wouldn’t get in touch with a members’ friend or relative. 

Two Interesting Office Tools 
By Nancy DeMarte, 2nd Vice President, The Sarasota Technology Users Group, FL 

August 2017 issue, Sarasota Monitor 

www.thestug.org 

With the new Windows 10 Creators update getting all the attention, it’s easy to miss the fact that 

Microsoft has also been rolling out new and improved features for Office gradually this spring and 

summer. They arrive as automatic updates to Office 365, the subscription version. I find them when I 

use an Office app or check the “What’s new?” section at the bottom of the Account section in any 

Office app file. (e.g., open Word> select a blank document> File > Account > What’s New?)  

 

Here are a couple of the new tools you might be interested in: 

Draw tab with Pens (for Word, Excel, and PowerPoint 2013 & 2016 in Office 365) 

 
This set of pens, pencils and highlighters in Figure 1 was created for touch screens and pen-enabled 

devices. However, I found that I could use all the pens by clicking and dragging my mouse pointer 

on my non-touch laptop screen. To enable these pens, first add the Draw tab to the ribbon. Open 

the Word app, for example, and open a blank document. Click File > Options > Customize Ribbon, 

and then click the checkbox next to Draw in the right pane > OK.  It will remain on the ribbon until 

you repeat this process and uncheck the box. 

 

Click a pen or highlighter to select it; click again to deselect it. Click the Thickness and/or Color 

menus to customize the lines. Then draw, write, or highlight text with your finger, stylus or mouse, 

depending on your screen capability. Use the Ink Editor to mark up a draft document on the 
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screen. Click the Convert to Shape tool and your next hand drawn circle will become 

perfect. If you don’t get an expected result, click the Eraser, and then click the pen 

marks to remove them. With a little practice, the Draw tab tools can enhance Word 

documents, PowerPoint slides, and Excel sheets or charts.  

 

PowerPoint Designer (Office 2016 for Office 365 only) I find PowerPoint Designer very 

useful for creating professional-looking slides. Introduced in the fall of 2015, it has been 

improved and expanded through recent updates. Its purpose is to offer some optional design 

layouts for PowerPoint slides, like the Title or Title & Content slides. Once enabled, it activates 

when you insert up to 4 photos into a slide along with text. A menu of slide designs using your 

content appears to the right 

of the workspace. Click any 

layout to preview how it 

looks on your slide. (See 

Figure 2)  

 

To use Designer, you must 

be connected to the 

Internet because the 

designs are located there. 

Also, you must be using one 

of the many PowerPoint 

design themes rather than 

one from a non-Office source or one you created yourself. 

Figure 2 below is a PowerPoint Title slide using one of the design Ideas from the gallery. First, I 

chose a theme from the opening screen. Then I added Asheville, NC, as the title of the 

presentation and inserted a photo I had taken near there. Several design layouts showed up in 

the right pane. I chose this one. 

 

The Designer also offers ideas for text layout. For example, Figure 3 shows a slide on 

which I had typed a 

bulleted list of four things to 

do in Asheville. Then I 

chose this Smart Art layout 

from the Design Ideas 

menu. (The Smart Art tool is 

always available on the 

Insert tab in the Illustrations 

group.) If I wanted to 

return to my original 

layout, I could right click 

the Smart Art slide and 

select “Convert to Text. 
 

If you prefer not to see any Designer ideas, you can turn off the feature. With a PowerPoint 

slide open, click File > Options > General, and remove the checkmark next to “Automatically 

show me design ideas.”  Stay tuned for more new Office tools and features in the future. 

Go to Page 1 
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  By Jeannine Sloan 

AI Tested in Real Time 
Huawei has turned one of its phones into a dog-collision avoidance system for cars as part of 

an unusual publicity campaign. The Chinese firm invited BBC's Rory Cellan-Jones to try out the 

artificial intelligence feature for himself at the Mobile World Congress trade show in Barcelona. 
http://www.bbc.com/news/av/technology-43240740/huawei-s-ai-phone-tested-by-driving-car-at-dog 

 

How to Disable Facebook's Facial Recognition Feature 
To turn off facial recognition on your computer, click on the down arrow at the top of any 

Facebook page and then select Settings. From there, click “Face Recognition” from the left 

column, and then click “Do you want Facebook to be able to recognize you in photos and 

videos?” Select Yes or No based on your personal preferences. On mobile, click on the three 

dots below your profile pic labeled “More” then select “View Privacy Shortcuts” then “More 

Settings,” followed by “Facial Recognition.” Click on the “Do you want Facebook to be able 

to recognize you in photos and videos?” button and select “No” to disable the feature. 
https://lifehacker.com/how-to-disable-facebooks-facial-recognition-feature-1823400295 

https://www.treasury.gov/resource-center/faqs/CFIUS/Pages/default.aspx 

 

CFIUS, Powerful and Unseen, Is a Gatekeeper on Major Deals 
The Committee on Foreign Investment in the United States, or Cfius (pronounced Sif-e-us), 

investigates mergers that could result in control of an American business by a foreign 

individual or company, judging whether the deal could jeopardize the national security of the 

United States. 
https://www.nytimes.com/2018/03/05/business/what-is-cfius.html 

 

Good Question 
A major privacy rights fight between Microsoft Corp<MSFT.O> and the Justice Department 

reaches the Supreme Court this week, with the justices considering whether U.S. law allows 

prosecutors to compel technology companies to hand over data stored overseas. https://

www.reuters.com/article/us-usa-court-microsoft/u-s-supreme-court-weighsmicrosoft-overseas-

data-fight-idUSKCN1G90IN 
 

Improve Your Google Searches 
For a product that’s used so frequently, there’s a lot Google can do that you might not know 

about. With that in mind, we’ve rounded up tricks to help you get the most out of Search, from 

simple tricks for narrowing down your results to more advanced methods for finding hidden 

files and pages online. Read the Mental Floss article here: 
 https://tinyurl.com/yaaxat2q 
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Quickkey 
Simply press Ctrl + Shift + T to reopen the most recently closed tab and get back to what you were 

doing (Cmd + Shift + T on Macs). 

 

Free Up Hard Drive Space On Windows 10 
Running low on disk space? In this guide, you'll find seven ways to delete junk files and get rid of 

apps and games you don't use to reclaim storage on Windows 10. 
https://www.windowscentral.com/best-7-ways-free-hard-drive-space-windows-10 

 

Who is Using Artificial Intelligence Products 
You are! Read the article at MIT Tech Review:  
https://tinyurl.com/ybaot2gr 

 

Carrier Lookup 
Enter a phone number and we'll return the carrier name and whether the number is wireless or 

landline. This carrier lookup service is number portability aware; it works with ported phone numbers 

from most countries. We also return the email-to-SMS and email-to-MMS gateway addresses for USA/

Canadian phone numbers. 
https://freecarrierlookup.com/ 

 

Word to Remember: arXiv 
arXiv (pronounced "archive") is a repository of electronic preprints (known as e-prints) approved for 

publication after moderation, that consists of scientific papers in the fields of mathematics, physics, 

astronomy, computer science, quantitative biology, statistics, and quantitative finance, which can 

be accessed online. In many fields of mathematics and physics, almost all scientific papers are self-

archived on the arXiv repository. Begun on August 14, 1991, arXiv.org passed the half-million article 

milestone on October 3, 2008, and hit a million by the end of 2014. By October 2016 the submission 

rate had grown to more than 10,000 per month. 
https://en.wikipedia.org/wiki/ArXiv  

 

It began as a physics archive, but soon expanded to include astronomy, mathematics, computer 

science, quantitative biology and, most recently, statistics. 
https://arxiv.org/ 
 

Stop Data Mining 
A directory of Opt-Out links to stop data brokers from selling your personal information. (Note: Is the 

effort worth the result?) 
https://www.stopdatamining.me/opt-out-list/ 
 

Machine Learning 
Machine-learning services are both a powerful revenue generator and key to Amazon’s AI flywheel, 

as customers as disparate as NASA and the NFL are paying to get their machine learning from 

Amazon. https://www.wired.com/story/amazonartificial-intelligence-flywheel/ 

 

 

 

 

https://en.wikipedia.org/wiki/ArXiv


April 2018  The Digital VIKING 9 

How to Increase Productivity Using Run Commands 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 

https://dottech.org/196102/how-to-increase-your-productivity-using-simple-windows-run-commandstip/
#pAh0F6TuUSycPw4g.99 
 

Go to Page 1 
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Special Interest Groups (SIGs) 
 
Most SIGs will meet at Edina Executive Plaza, Conference Room #102, 5200 
Willson Road, Edina, MN 
 Confirm with a SIG group if they meet elsewhere. 
For more info contact the SIG Leader(s) listed here. 

 w Work phone    h Home phone   c Cell phone 
 * Meets at an alternate location 

Get SIG announcements! 
Link from www.tcpc.com 

Directions to Edina Executive Plaza 
for Systems on Saturday, Access,  
Word and Picture Perfect SIGs: Take 
Highway 100 to the 50th Street/Vernon 
exit. [If you have come from the north, 
cross back over Highway 100 to the 
east side.] Take the first right and go 
past Perkins [The golf course will be on 
your left.] and continue on the east 
frontage road (Willson Road) to the 
next building—5200 . There is ample 
parking in the building’s lot. 
Conference Room #102 is on 1st floor. 

Directions to Summit Place for General Meetings: 
Proceed to Eden Prairie Center Flying Cloud Drive . [Flying Cloud Drive runs along 
the West side of the Eden Prairie Center.]  Once you have driven past Eden Prairie 
Center (on the left) along Flying Cloud Drive you will come to a stop light at Prairie 
Center Drive.  The next intersection with a stop light and left turn lane is Fountain 
Place. Turn left at Fountain Place and go straight into the parking lot. Turn left again 
to the first covered entry way of Summit Place.  There is plenty of parking in the 
large parking lot in front of the first Summit Place covered entry way.  When you 
enter the door at the first covered entry way, ask to be directed to the Performance 
Room for the TC/PC meeting.  For a map of more detailed directions and info on 
Web SIG and Board meeting, check the TC/PC website. 

Help yourself by helping others! 

Join the team & share your knowledge with others. 
Contact TC/PC at www.tcpc.com 

Board of Directors* 
All members are welcome! Check 
www.tcpc.com for location. 
Selected Saturday mornings 
 

Linux on Saturday 
This is for the Linux newbie and those trying 
to come over from Microsoft to a different 
operating system. 
Second Saturday @ 9 AM-Noon 
Note: No Meetings June-August 
 
Jack Ungerleider 612/418-3494 c 
 jack@jacku.com 

 
Tech Topics 
Technical presentation/discussion on 
various technical topics from the following 
areas:  
•         Web/Internet  
•         Mobile Devices and Apps  
•         Playing with Programming  
•         DIY (3D Printing, R-Pi, other hobby 
electronics, etc.) 

 

Second Tuesday @ 6:00-7:00 PM 
Every  month 
Right before the general meeting. 
 
Jack Ungerleider 612/418-3494 c 
 jack@jacku.com 

Microsoft Access 
All levels. Presentations by expert develop-
ers within the group and by MS reps. 
Third Saturday 9:00 AM—Noon 
Note: No Meetings June-August 
 
Steve Kuhlmey 952/934-8492 
 skuhlmey@hotmail.com 
 

Microsoft Office 
Addresses the use, integration, and nuanc-
es of the Microsoft Office applications. 
Combined with Systems on Saturday 
Third Saturday of the Month  
9:00 AM—Noon 
Note: No Meetings June-August 
 
 
Steve Kuhlmey 952/934-8492 
 skuhlmey@hotmail.com 
 
 

http://www.tcpc.com
http://www.tcpc.com
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Device Power Options 
By Jim Cerny, Forum Leader, Sarasota Technology Users Group, Florida 

September 2017 issue, Sarasota Monitor 

www.thestug.org 

jimcerny123 (at) gmail.com 

On – Off – Shutdown – Sleep – What are all these power options?  Today our computer 

devices usually have several choices for “power”, even the “off/on” switch does more than 

just turn your device on or off!  Many devices today – especially devices that use batteries – 

give us more choices about how we use the power we have available.  One of the best 

ways to learn the options for your device is to use Google – enter “power options for my 

iPad” for example.  You will be surprised at what is available.  Here we will look at the usual 

basic power options used by most devices (iPads, iPhones, Windows computers, laptops, 

etc.). 

 

The main power button, the one you use to turn your device “on” or “off”, is really only 

putting the device in or out of “sleep” mode.  Sleep mode uses very little power and allows 

your device to keep your recent activity in memory, so you can easily resume where you 

left off when you return (by hitting the same button to turn it back “on”).  This is a good 

thing for most devices, especially phones, because you will still get incoming calls and 

messages, etc. 

 

To turn your iPad or iPhone device completely off (also known as “shutdown” or “power 

off”) you need to HOLD DOWN the off/on button until you see “slide to power off” on the 

screen.  Slide where indicated and your device will be completely off.  You will use NO 

battery at all and you will NOT be able to get a call, text messages, or alarms until you turn 

it back on.  To turn your iPad or iPhone back on from “power off” you need to HOLD DOWN 

the off/on button until you see a white apple on the screen.  Release the button and wait 

for your device to power up.  Other power settings for your iPad or iPhone are in “Settings” 

then “battery” or “Display and Brightness”. 

 

For Windows computers and laptops, touch (or left-click) on the “Windows” button at the 

far left of the taskbar and then touch the power icon symbol (a circle with a short vertical 

line at “noon”) and then select “shut down”.  To turn your Windows computer back on, just 

hit the start button. A complete shutdown or power down is good for your device because 

when you power it back up it does a good check of everything to make sure all is working 

as it should.  

 

Laptops have several more power options. You can find these options in the control panel 

or enter “power” in the search box to find “power and sleep settings”, or ask Google how.  

Here you can adjust your settings as to how long (minutes) your screen stays on with no 

activity before going to sleep.  But you can also select power options for when your laptop 

is running on the battery or plugged into the power outlet.  You can also select what 

happens when you close the lid of your laptop.  (When my laptop is at home it is 

connected to a large monitor screen, so when I close the lid of my laptop, I want it to “do 
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nothing”).  The “restart” option will shut down your Windows computer and then boot it 

back up right away. 

 

Other possible options for devices include what to do when your battery gets low on power, 

adjusting the brightness of your screen, even slowing the speed of your device.  There 

seems to be an option or setting for just about anything these days.  You need not concern 

yourself with most of the power options available unless you are using your device many 

hours a day and frequently see the “low battery” message.  Another easy solution to being 

low on power is to buy and charge up an external power pack.  This can come in handy for 

long airline flights when you will not be able to plug in to recharge your device.  But then 

again, maybe putting yourself into “sleep mode” could be for the best anyway! 

 

 

The “power” icon  
 

    

 The “settings” icon 

 

 

 

 

The “settings” app icon for iPads and iPhones 

 

 

 

The “battery” icon showing power level 

 

 

 

No Personal Privacy [& Patch My PC Updater & More] 
By Matt Batt, President, The Computer Club, Inc., Florida 

December 2017 issue, The Journal of The Computer Club 

www.scccomputerclub.org 

mbatt453 (at) gmail.com 

I want to share (1) something to think about as we enter this time of “no personal 

privacy;” (2) a very useful program for keeping your PC applications up-to-date; and (3) a 

fun website for displaying street views of houses. 

 

My wife was reading a book on her Kindle and was getting close to the end. She wanted 

to finish the book, so she cloistered herself in the snug family room chair and had at it. After 

about half an hour, she finished the book and explained that it really was a great book and 

Go to Page 1 
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she really enjoyed it. A moment or two later, her cell phone made the noise for an incoming 

email and she reached over and read it. It was from Amazon and it asked her how she liked 

the book that she just finished. That was so spooky! It really made us feel like our privacy had 

been compromised. I’m a very strong proponent of technology advances and all the good 

things that it can bring, but this just seemed like too much and too close. 
 

A couple of days later, she started another book, read a few chapters and had to put it 

down as things get busy around the first of the month. Sure enough, after a couple of days, 

she gets an email from Amazon asking, “how’s it going.” Guess she wasn’t reading enough 

and needed to be prodded. Now, I don’t know what you think of that intrusion, but I find it 

really disturbing. Guess we’ll have to get used to it or take the Kindle offline. 

 

An important part of being safe online is keeping your computer’s software up-to-date. 

Outdated software often contains security exposures that can provide hackers access to 

your computer. Outdated software can also be buggy and have performance issues which 

are usually fixed with a newer version of the software. Unfortunately, if you have lots of 

different programs this is an onerous task. 

 

Patch My PC Updater will make patching your PC easy. It is free and keeps over 165 apps 

up-to-date on your computer. It is an easy way to update or install any of these programs 

on to your computer. 

 

When you open Patch My PC Updater, it will scan your system for outdated programs. It will 

show programs that are outdated in Red, programs that are updated in Green, and 

programs that are not installed in Black. With one click you can easily do all your updates. 

You can download Patch My PC from https://patchmypc.net/download. 

 

On a more fun note, I’ve been sharing a website called www.showmystreet.com. When you 

go to the site, you get a box where you can type in an address. It’s a simple interface that 

lets you display almost all locations. Just start typing the location’s address and the 

background Google Map is updated in real-time. Like any other regular Google Map, you 

can drag the map, zoom in/out, and select the following views: map, satellite, hybrid, and 

terrain. Wherever available, Show My Street will automatically display the Google Street 

View of the address. Type the address one character at a time and watch the location that 

it displays. It’s amazing. The views can be directly shared on Twitter and Facebook. You can 

also obtain a direct URL to the view and share it with your friends online. 

 

Be careful out there! 

 

Go to Page 1 

https://patchmypc.net/download
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You have just read an issue of The Digital Viking. 

 
Would you like to receive this delivered directly to your email or business each month? 

 
As a member of TC/PC, the Twin Cities Personal Computer Group, one of the benefits 

 is reading this monthly publication at www.tcpc.com.. 
 

As a member of TC/PC, you may attend any or all of the monthly Special Interest Group (SIG) meetings and be eligible for 
software drawings. The small membership fee also includes  

access to real-live people with answers via our helplines, discounts, and various other perks. 
 

Does membership in this group sound like a good way to increase your computer knowledge? 
 

It’s easy to do! Simply fill in the form below and mail it to the address shown. 
(If you use the form in this issue, you will receive an extra month for joining now.) 

 

 
Here’s the info for my TC/PC Membership: 
 

Full name_____________________________________________________ 

 

Company name________________________________________________ 

 

Address______________________________________________________ 

 

City_______________________________ State_________ Zip__________ 

 

Home  Business  Change address: Perm. Temp. ‘til ___________ 

 

Home phone____________________  Work phone____________________ 

 

Online address(es) _____________________________________________ 

 

Where did you hear about TC/PC? _________________________________ 
 
 I DO NOT want any of my information disclosed. 

 I DO NOT want to receive any mailings 

 
Administrative Use Only     Rec’d_____________________  Chk#_______________ 

 4/18 
I’m signing up for: 
 

 Individual/Family Membership ($18) 

 Business Membership ($100) 

If an existing member your # __________ 

Make checks payable to: 

Twin Cities PC User Group 
341 County Rd C2 W 
Roseville, MN 55113 
 

http://www.tcpc.com 
 

 Check #__________  Bill me 

 New member  Renewal  Prior member 

I’m interested in: 

 Training classes  Volunteering 

 Special Interest Groups: New User, Access, 
etc. 

List here: 
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FIRST CLASS MAIL 341 County Rd C2 W 
Roseville, MN 55113 

November 8, 2011 • 7 PM 

General Meeting 
 

The Microsoft Store 
 

The Microsoft Store 
162 South Avenue 

Mall of America 

More info: www.tcpc.com 

April 10, 2018 
General Meeting 7:00 PM 

 

Google Drive and Apps 
 

Presenter: Bill Ryder 

Summit Place 
8505 Flying Cloud Dr. 

Eden Prairie, MN 55344 
 

More info and map: www.tcpc.com 
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